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Program License Agreement 
The information in this document is subject to change without notice and shall not be 
construed as a commitment on the part of Connect One.  

Connect One assumes no liability for any errors that may appear in this document. 

The software described in this document is furnished under a license agreement and 
may be used or copied only in accordance with the terms of such a license 
agreement. It is forbidden by law to copy the software on any medium except as 
specifically allowed in the license agreement. No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, 
including but not limited to photocopying, recording, transmitting via fax and/or 
modem devices, scanning, and/or information storage and retrieval systems for any 
purpose without the express written consent of Connect One. 

iChip, AT+i and Connect One are trademarks of Connect One Ltd. 

Copyright © 2000–2012 Connect One Ltd. All rights reserved. 
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About This Guide 
The purpose of this User Manual is to familiarize prospective customers with the 
functionality of Connect One’s II-EVB-630W using the iChipConfig Utility and AT+i™ 
commands. 

This manual contains the following sections: 

Product Overview: Explains the iChip™ CO2128SEC as the heart of the 
II-EVB-630W. It describes the product uses and features and provides guidance for 
using this manual. 

Getting Started: Describes the II-EVB-630W package contents, unpacking and 
installation instructions, and diagrams. 

Firmware and Parameters Update: This section explains how to perform firmware 
and parameters update.  
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Warranty Statement 
Connect One warrants to the Customer that the Products to be delivered hereunder 
will function in accordance with the specifications published with regard thereto by 
Connect One, under conditions of normal use and service and when used in 
accordance with Connect One's instructions, for a period of 12 (twelve) months from 
shipment by Connect One or its distributor to the customer. Connect One will, at its 
option, repair or replace Products that fail to perform as aforesaid.  The Customer 
shall ship defective Products to be repaired or replaced to Connect One under 
warranty at Connect One's expense, and Connect One shall, at its expense, ship the 
repaired Products or its replacement to the Customer. 

In no event will Connect One's liability under the foregoing warranty exceed the 
purchase price of the defective Products. 

The warranty set forth above shall not apply (i) with respect to defects or damage 
caused by the use of unauthorized parts, the making of unauthorized repairs or 
improper use or maintenance, (ii) if service or repairs of the allegedly defective 
Products have been performed by persons other than qualified persons who have 
been properly trained to perform the same, (iii) if the allegedly defective Products 
have been affected by alterations, modifications or other tampering or misuse, (iv) if 
the allegedly defective Products have been removed from their original packaging 
prior to sale to the end-user or (v) if the allegedly defective Products have been used 
otherwise than in accordance with Connect One's instructions. 

The provisions of the above sections set forth the Customer’s sole and exclusive 
remedies with regard to Product failure.  CONNECT ONE MAKES NO OTHER 
WARRANTIES, EXPRESSED OR IMPLIED, WITH RESPECT TO THE PRODUCTS, 
INCLUDING BUT NOT LIMITED TO ANY WARRANTY OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF PATENT OR OTHER 
INTELLECTUAL PROPERTY RIGHTS.  THERE ARE NO OTHER WARRANTIES WITH 
RESPECT TO THE PRODUCTS ARISING FROM ANY COURSE OF DEALING, USAGE OR 
TRADE OR OTHERWISE.  IN NO EVENT SHALL CONNECT ONE BE LIABLE FOR 
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES WHETHER UNDER THIS 
AGREEMENT, IN TORT OR OTHERWISE, OR FOR AN AMOUNT IN EXCESS OF THE 
ACTUAL AMOUNT PAID BY THE CUSTOMER TO CONNECT ONE FOR THE FAILED 
PRODUCTS. 
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Revision History 

23-3750-11 
 

Version Date Description 

1.0 December 2007 Initial preliminary version 

1.1 May 2009  

1.2 April 2012 Updated product pictures, screen captures 
and components lists.  
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1 Product Overview 
Connect One’s II-EVB-630W offloads IP connectivity tasks from a host processor or 
device. II-EVB-630W supports effortless integration of many upper-layer Internet 
protocols using either AT+i™ commands or the iChipConfig Utility, both of which are 
described in this document.  

II-EVB-630W features include the ability to stream data over TCP or UDP sockets (up 
to 10 simultaneous active sockets are available) and manage two listening sockets. A 
secure socket (SSL3/TLS1) is fully supported. Additional features include the ability 
to send and receive emails with or without attachments, a built-in web server with 
two internal websites, one for remote control and management of the II-EVB-630W 
and the other for the device; HTTP, FTP, and Telnet clients; and the SerialNET™ 
(Device Server) mode, a plug-and-play operating mode that enables the connection 
of any device with an RS232 interface to the Internet without changing anything on 
the device’s hardware or software.  

1.1 iChip CO2128SEC — The II-EVB-630W Internet 
Engine 
The host processor communicates with the II-EVB-630W via Connect One’s high-
level AT+i command set. AT+i commands are simple ASCII characters that are sent 
across the RS232 interface. The AT+i Application Programming Interface (API) 
requires writing just a few lines of code on the host processor to implement Internet 
connectivity. 

AT+i commands make it very easy to configure, test, and implement high-level 
Internet protocols with virtually no understanding of TCP/IP or other Internet 
protocols. Using AT+i commands, the device only needs to tell the II-EVB-630W 
what task to perform, but not how to perform it. For example, if the device has to 
send textual email, after a one-time short configuration of subject, recipient, mail 
account, etc., the device sends AT+iEMA:<lines of text>. 

The iChip CO2128SEC inside the II-EVB-630W establishes a connection or uses the 
existing one, builds the email (headers and content), connects to the SMTP server 
and sends the email. A status report is sent to the device upon completion. All these 
actions are completely hidden from the device and only require sending a few 
characters in addition to the email content. This mode of operation is applicable for 
all features of the II-EVB-630W. 

1.2 How to Use this Manual 
iChipConfig Utility is a front-end Windows-based user interface for the AT+i 
commands. The iChipConfig Utility, combined with the II-EVB-630W, enables quick 
and full product configuration, serial-based and Web-based updating of firmware, 
and packaging of a website and parameters file. This functionality is achieved from 
any device, machine, or system. 
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Note: From this point onward, this manual assumes that you have the iChipConfig 
Utility installed. The configuration, running, and testing of the II-EVB-630W is 
demonstrated via the iChipConfig Utility, although they can also be carried out using 
AT+i commands. For a complete description of the AT+i interface and commands, 
refer to the AT+i Programmer's Manual on Connect One’s website: 
http://www.connectone.com. 

To set up the iChipConfig Utility, refer to the iChipConfig Utility User Manual. 

The latest version of the iChipConfig Utility can also be found on Connect One’s 
website: http://www.connectone.com. 

A reference design for using iChip CO2128SEC with a built-in MAC and external PHY 
(Davicom DM9161A) and WiFi using Marvell 88W8686 802.11b/g chipset can be 
found at http://www.connectone.com. 

 

http://www.connectone.com/
http://www.connectone.com/
http://www.connectone.com/
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2 Getting Started 
This section describes the contents of the II-EVB-630W package, provides additional 
relevant documentation to enhance and fine-tune the II-EVB-630W functionality, and 
includes unpacking and first-time configuration instructions. The final section of this 
chapter offers several ways to test the II-EVB-630W LAN connection. 

2.1 What’s in the Package? 
The II-EVB-630W is a turnkey boxed solution and, as such, is supplied with all 
necessary accessories. The package includes the following items: 

• II-EVB-600W motherboard 

• WiFi 802.11b/g daughterboard (BRD-IIDB-W2SW1) 
• RS232 male/female cable 

• RJ45 Cat 5 100BaseT cable 

• RJ11 Phone Cable 

• USB A to B Cable 

• 110V or 220V power supply 

• Two extra iChips CO2128SEC 

2.2 Additional Documentation 
The II-EVB-630W is built around the iChip CO2128SEC. Great flexibility in 
configuration and operation of this product can be achieved via proper use of the 
AT+i commands.  

The release package includes documentation about the AT+i Protocol, including the 
AT+i Programmer's Manual. 

For the sake of simplicity, the II-EVB-630W configuration and operation is described 
in this document mainly through the iChipConfig Utility. 

The release package contains the iChipConfig Utility and the iChipConfig Utility User 
Manual. 

Note: Because documentation, utilities and firmware files change from time to time, 
be sure to check for the latest version on Connect One’s website: 
http://www.connectone.com. 

http://www.connectone.com/
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2.3 Unpacking and Installing  
The II-EVB-630W installation is simple and all the required accessories are supplied 
with the device. 

The II-EVB-630W is provided pre-configured to work with either LAN or WiFi using 
COM0 on the II-EVB-630W as host interface. For additional configuration options 
check section 2.5 Jumper Settings. 

� To install the II-EVB-630W and connect it to a LAN network: 

1 Connect the RJ45 cable to the II-EVB-630W RJ45 port as shown in the figure 
below. Connect the other end of the cable to a 10/100BaseT or 100BaseT 
Ethernet switch or hub.  

 

 

RS232 

RJ45 

Note: To connect the II-EVB-630W directly to a PC Ethernet controller, a cross 
or regular cable maybe required (not supplied) depending on your NIC card.  

2 Connect the RS232 male side of the cable to the II-EVB-630W RS232 port and 
the female side to your device or PC’s COM port. 

3 Connect the power supply to the DC jack on the II-EVB-630W and apply power. 

The Link LED (yellow) on the RJ45 should now be on and the Activity LED 
(green) should blink occasionally, indicating network traffic.  

Getting Started  10 
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� To install the II-EVB-630W and connect it to a WiFi Network: 

1. Make sure a WiFi 802.11b/g Access Point is properly configured and powered. 

2. Connect the RS232 male side of the cable to the II-EVB-630W RS232 port and 
the female side to your device or PC’s COM port. 

 

 
WiFi 

daughter 
board  

 

3. Connect the power supply to the DC jack on the II-EVB-630W and apply power. 

Getting Started  11 
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2.4 Connectors and Switch Positions 

2.4.1 Connectors 
 

 Name Type Function 
1 J1 HEADER 20X2 EBI BUS 

2 J2 HEADER 20X2 EBI BUS 

3 J4 HEADER 10X2 HPI* 

4 J5 DB9 – FEMALE COM0  

5 J6 HEADER 5X2 SSC* 

6 J7 RJ11 Telephone Line (from UART1) 

7 J8 DB9 –MALE COM1  

8 J9 RJ45 10/100BaseT 

9 J10 HEADER 4X1 TWI 

10 J12 HEADER 6X1 SPI1 

11 J13 HEADER 6X1 SPI0 

12 J14 DB9 – FEMALE COM2 

13 J15 USB-A USB Host 

14 J16 DC-JACK POWER Supply 

15 J17 USB-B USB Device 

16 J18 BLOCK 2 Pin Analog Input 

17 Socket 
Modem 

4 connectors 2mm 
pitch 

Analog modem 

 

2.4.2 Switches 

 Name Type Function 
1 SW1 PUSH BOTTOM  MSEL 

2 SW2 PUSH BOTTOM  RESET 

3 SW3 TOGGLE SWITCH POWER On/Off 

2.5 LED Positions 
 

 Name Type Function 
1 D1 G.LED RXD0 
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2 D2 G.LED TXD0  

3 D3 G.LED DTR1 

4 D4 G.LED CD1 

5 D5 G.LED RXD1 

6 D6 G.LED TXD1 

7 D7 G.LED RXD2 

8 D8 G.LED TXD2 

9 D13 R.LED iChip Error 

10 D14 G.LED FW_RDY 

11 D17 G.LED DATA READY 

12 D19 R.LED 3.3V VDDIO 

13 D20 R.LED 1.2V External  

 

2.6 Jumper Settings 

 Name Setting 
1 JP2 1-2 ONREG Pin=0 working with external VDD core ; 2-3 

ONREG Pin=1 working with internal VDD core  

3 JP5 ON –External VDDCore 

4 JP6 ON- Enable 1K Pull-up Resistor On HPI_nWAIT signal * 

5 JP7 ON- Enable COM0 (only when HPI is disabled)  

7 JP9 ON- Enable HPI * 

8 JP10 ON- Enable Socket Modem (on UART1) 

9 JP11 ON- Enable COM1 

11 JP13 ON- Enable 1K Pull-up Resistor On TWI_TWD signal. 

12 JP14 ON- Enable 1K Pull-up Resistor On TWI_TWCK signal. 

19 JP21 1-2 = COM0+SSC ;  2-3 = HPI 

20 JP22 1-2 = MII  ;  2-3 = RMII+COM1 

21 JP23 1-2 = S.C  ;  2-3 = SPI0 

22 JP24 1-2 = SPI1 ;  2-3 = TWI 

23 JP25 1-2 = LAN_EN ; 2-3 = LAN_DIS; 

24 JP26 1-2 = BYPASS ROM ;2-3  = ENGAGE ROM 

25 JP27 1-2 = UHP_EN ; 2-3 = UHP_DIS 

26 JP28 ON – COM2 Enable  COM2_EN 

27 JP29 ON – Enable Parallel Flash  
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2.7 Bill of Materials 

2.7.1 II-EVB-2128-PLC Motherboard 
Quantity Reference Part 

46 

C18,C22,C23,C24,C25,C26,C27,
C28,C29,C30,C31,C32,C37,C41,
C43,C44,C49,C50,C51,C52,C55,
C57,C59,C60,C65,C66,C67,C68,
C71,C72,C73,C74,C75,C76,C77,
C82,C86 ,C91,C98,C99, C102, 
C103,C105,C106,C111, C112 100NF 

2 C33,C34 22PF 

8 
C20,C42,C56,C58,C88,C92, 
C108,C113 10UF/16V 

5 C35,C36,C39,C107,C109 1UF/16V 

13 
C45,C46,C47,C48,C61,C62,C63,
C64,C83,C84,C85,C87,C93 470NF 

2 C53,C54 1NF/3KV 
2 C69,C70 100UF/16V 
3 C94,C95,C104 47PF 
2 C96,C97 1000UF/25V 
2 C100,C101 15PF 

10 
D1,D2,D3,D4,D5,D6,D7,D8,D14,
D17 G.LED 

1 D10 1N4001 
1 D11 MUR115 
6 D12,D15,D16,D21,D22,D23 LL4148 
3 D13,D19,D20 R.LED 
1 F1 RXE020 

8 
JP2,JP21,JP22,JP23,JP24,JP25, 
JP26,JP27 JMP3 

10 
JP5,JP6,JP7, JP9,JP10, JP11, 
JP13,JP14, JP28,JP29 JUMPER 

2 J1,J2 HEADER 20X2 FEM 
1 J4 HEADER 10x2 

2 J5,J14 DB9 FEM 
1 J6 HEADER 5X2 MALE 
1 J7 RJ11 
1 J8 DB9 MALE 
1 J9 ERNI 
1 J10 CON4 
2 J12,J13 CON6 
1 J15 USB-A 
1 J16 DC-JACK 
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1 J17 USB-B 
1 J18 CON2 
1 LS1 HPE1206 
1 L1 2961666681 
5 L2,L9,L10,L11,L12 BK2125HM601 
1 L4 68UH/1A 
1 P1 POT 

10 
R62,R65,R78,R79,R80,R90,R91, 
R145,R146,R151 10K 

1 RV1 DSS-301L 

9 
R50,R85,R87,R136,R149,JP30, 
JP31,JP32,JP33 0 

42 

R7,R8,R9,R10,R11,R12,R13,R14,
R15,R16,R17,R18,R19,R20,R21,
R22,R23,R24,R25,R26,R27,R28,
R29,R30,R31,R32,R33,R34,R35,
R36,R37,R38,R39,R40,R41,R42,
R43,R44,R45,R46,R47,R48 33 

16 

R51,R53,R54,R55,R56,R57,R58,
R59,R60,R61,R63,R71,R72,R73,
R115,R150 100K 

15 

R66,R67,R74,R75,R76,R77,R88,
R89,R113,R114,R128,R130, 
R134,R143,R147 470 

2 R68,R69 2Ω 
1 R70 10 
4 R81,R82,R83,R84 49.9 1% 
1 R86 6.8K1% 

9 
R106,R107,R108,R109,R110, 
R111,R112,R117,R135 3K 

1 R116 100 
1 R118 300 
4 R119,R121,R123,R124 27 
3 R120,R122,R126 15K 
1 R131 4.7K 
2 SW1,SW2 TACK_SW 
1 SW3 SWITCH ON/OFF 
1 U1B CO2128 
1 U2 29LV160BT-70EC 
1 U3 NC7S04 
3 U4,U11,U17 SP3243ECA 
1 U5 74HCT245 
2 U6,U10 74LV244 
3 U7,U12,U18 74LVX240M 
1 U8 Socket For Modem 
1 U9 LM386 
1 U13 F4100-50MHZ 
1 U14 DM9161A 
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1 U19 LT1086CM 
1 U20 TPS76912 
1 U21 LM2591HVS-3.3 
1 U22 TS5A3159 
2 U23,U26 AD8030 
1 U24 SP708RCN 
1 U27 LM75A 
1 Y2 12MHZ 

 

2.7.2 II-DB-W2SW1 Daughterboard 
 
Quantity Reference Part 

2 C6,C8 100UF/6.3V 
5 C9,C11,C14,C15,C16 100NF 
2 C10,C13 1NF 
1 D1 G.LED 
2 J1,J2 HEADER 20X2 MALE 
1 J3 SMA 
1 L2 68UH/1A 
1 R1 0 
1 R3 330 
4 R6,R7,R9,R10 100K 
1 R11 N.C 
1 U5 W2SW0001 
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2.8 Schematics 
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2.9 Running the iChipConfig Utility 
� To invoke the iChipConfig Utility: 

1 Select Programs > ConnectOne > iChipConfig from the Windows Start 
menu. The iChip Configuration Tools window is displayed: 

 

2 Select the desired operation by clicking the appropriate icon. 

When an icon is selected (except Exit), the iChipConfig utility attempts to locate 
the II-EVB-630W on one of the PC’s COM ports. 
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If the II-EVB-630W is not located, the Serial Settings dialog box is displayed: 

 

This dialog box is also displayed if you select Serial Ports from the menu bar. 

3 From the Serial Port drop-down list, select the PC COM port to which the  
II-EVB-630W is connected. 

4 In the Baud Rate area: 

• Select the exact Baud Rate used by the II-EVB-630W. 

-or- 

• Select Scan if you don’t know the baud rate. 

If Scan is selected, the iChipConfig Utility runs through the various baud rates 
until the correct baud rate is found. The following message is displayed: 

 

Note: If the iChipConfig Utility still fails to find the II-EVB-630W, make sure that 
there is no open application, such as Palm HotSync, occupying the port. Switch 
to a different COM port and try Scan again. After iChipConfig has found the baud 
rate, you can easily change it using the Serial Settings dialog box. 

2.10 Configuring for Connection 
To connect on the LAN side, the II-EVB-630W needs basic LAN settings, such as IP 
Address, Subnet, and Gateway IP address. There are two ways to configure this set 
of parameters: 

• Dynamic IP Allocation (Via DHCP). 

• Fixed IP Configuration (Via User Assignment). 
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2.10.1 Dynamic IP Allocation 
By default, the II-EVB-630W is configured to gain LAN access via a DHCP server. 
Therefore, if a DHCP server is present, there is no need for additional configuration. 

Default settings can be restored using the AT+iFD command, which you can issue in 
the Dumb Terminal window. AT+iFD will revert all parameters to factory defaults. 

1 Specific configuration for acquiring LAN settings via DHCP can be carried out 
from the Quick Configuration window in the figure below: 

 

2 Select the Use DHCP checkbox and click Save. 

3 To activate these settings, recycle power to the II-EVB-630W. 

Note: II-EVB-630W supports DHCP Server extensions. This means that if your 
server’s assignees have additional LAN settings, such as an SMTP server, the  
II-EVB-630W automatically configures and uses these settings. 
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2.10.2 Fixed IP Configuration 
To configure the II-EVB-630W to work with a fixed IP address, the following 
parameters must be configured: 

1 Use the Quick Configuration screen to set the following parameters: 

• IP Address (DIP): Set it to the IP address you want the II-EVB-630W to 
have. 

• Subnet (SNET) 

• IP Gateway (IPG) 

2 Click Save and recycle power to the II-EVB-630W. 

These settings can also all be configured using the AT+i commands - AT+iDIP, 
AT+iSNET and AT+iIPG. Full details about these commands can be found in the 
AT+i Programmer's Manual. 

2.11 Testing the Connection 
The connection can be tested using any operation that causes the II-EVB-630W to 
send/receive information. For example, sending and receiving data over a socket, 
sending emails, or opening an FTP session. 

One of the simplest ways to test the connection is using the web client, as it requires 
no additional configuration. Assuming the LAN is connected to the Internet, you can 
use the client on the iChipConfig Utility to run the following test: 

1 From the Main menu, select the Get URL option. 

The iChip Configuration Tools window is displayed: 
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2 Type the full path of the URL you want to retrieve. 

3 Select an existing path for the file in order to save the URL page. 

4 Select the Show in browser option to automatically open your web browser and 
show the contents that the II-EVB-630W retrieved. 

5 Click Get to retrieve the file. 

Note: If the path you enter is not a full path to an object, such as JPG, file, or 
HTML page, enter “/” to enable II-EVB-630W to find the default page specified 
for this URL. 

6 The same option can be carried out using, for example, the following AT+i 
command: 
AT+iRLNK:http://www.google.com/. 

 

http://www.google.com/
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3 Firmware and Parameters Update 
This section describes the II-EVB-630W local firmware and parameters update 
procedures. It also describes how to create and use parameter files (*.RPF). 

3.1 Local Firmware Update 
The II-EVB-630W can be updated locally via the Tools > CO2128/2064 Monitor 
Mode command, or via the iChip Uploader feature of the iChipConfig Utility. First 
time installation of the firmware must be done via Monitor Mode. Successive 
firmware updates can be performed using the iChip Uploader, which is a much faster 
procedure that does not require re-installation of the boot loader. 

3.1.1 First-Time Firmware Installation Using Monitor Mode 
1. Open the iChipConfig utility. 

 

2. Click Tools > CO2128/2064 Monitor Mode. 

3. In the dialog box displayed, select the EBI Flash 8 Megabit option and click OK. 
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4. Recycle power to the II-EVB-630W while holding down the Mode Select (MSEL) 
switch for at least 5 seconds, and click OK to continue. 

 

5. The following window appears while the FPRO application is installed. 

 

6. The Monitor Mode dialog box is displayed. Click the FW Update button. 
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7. In the dialog box that appears, browse to the location of the Boot Block IMF file 
you obtained from Connect One, select the file and click Open. 

 

8. Click Yes when prompted. 

 

9. The following window appears while certain sectors of the flash are being erased 
and the boot block is being installed. 

 

10. OK the dialog box that appears when the boot block has been installed 
successfully. 

 

 

 

 

Firmware and Parameters Update  25 



II-EVB-630W User Manual Firmware and Parameters Update 

  

11. In the Monitor Mode dialog box, click the FW Update button again. 

 

12. In the dialog box that appears, browse to the location of the firmware IMF file 
you obtained from Connect One, select the file and click Open. 
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13. Click Yes when prompted. 

 

14. The following window appears while the firmware is being installed on the flash. 

 

15. OK the dialog box that appears when installation has completed successfully. 

 

16. Click the Exit Monitor Mode button on the Monitor Mode window to return to 
command mode. 

3.1.2 Updating Existing Firmware Using the iChip Uploader 
Note:  This procedure assumes that the SPI flash memory on the II-EVB-630W 
already contains a previous version of the iChip firmware. 

1. Open the iChipConfig utility. 
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2. Click the iChip Uploader via Serial icon. 

3. In the dialog box displayed, select the EBI Flash 8 Megabit option and click OK. 

 

4. The Monitor Mode dialog box is displayed. Click the FW Update button. 
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5. In the dialog box that appears, browse to the location of the firmware IMF file you 
obtained from Connect One, select the file and click Open. 

 

6. Click Yes when prompted. 

 

7. The following window appears while the firmware is being installed on the flash. 

 

8. OK the dialog box that appears when installation has completed successfully. 

 

9. Click the Exit Monitor Mode button on the Monitor Mode window to return to 
command mode. 
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3.2 Managing Parameter Files 
Parameters for the II-EVB-630W are stored in *.RPF files. Parameter files can be 
used to save current configurations to be loaded for later use or to automate product 
distribution.  

3.2.1 Saving the II-EVB-630W Configuration to an RPF File 
All or some of the parameters stored in the II-EVB-630W can be saved to a Remote 
Parameters File (RPF), or loaded from an RPF file onto the II-EVB-630W, with or 
without parameters configured on it. 

� To save the configuration to an RPF file: 

1 Select the Full Configuration icon. The II-EVB-630W Full Configuration window 
is displayed. 

2 Click File >Save as RPF File in the Full Configuration window. The RPF 
Parameters dialog box is displayed: 

 

3 Configure the following parameters: 

• Select the Start from factory defaults checkbox if you want to save the 
factory default settings as your new parameters. 

• Do not select the Start from factory defaults checkbox if you want to save 
your current configuration except for parameters in the RPF file. 

• Group: Not relevant.  

• Destination Chip Serial Number: Not relevant.  

• Click OK. 
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3.2.2 Loading an RPF File 
This section describes how to load an RPF file onto II-EVB-630W. 

� To load an RPF file: 

1 Select File | Load RPF file from the iChipConfig menu. The Open dialog box is 
displayed:  

 

2 Browse to and select the desired file. 

3 Click Open. All the parameters from the RPF file are loaded onto the II-EVB-
630W.  

4 If an illegal parameter value has been assigned, the iChipConfig Utility displays 
the illegal parameter and suggests to save the illegal parameter to a log file. 

Enter a new valid parameter value and Load/Save the RPF file again. 
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Authorized Distributor
 
  

Click to View Pricing, Inventory, Delivery & Lifecycle Information:
 
 
 
 Connect One:   

  II-EVB-630W-3-US-110  II-EVB-630W-3-EU-220

http://www.mouser.com/connectone
http://www.mouser.com/access/?pn=II-EVB-630W-3-US-110
http://www.mouser.com/access/?pn=II-EVB-630W-3-EU-220

	II-EVB-630W
	1 Product Overview
	1.1 iChip CO2128SEC — The II-EVB-630W Internet Engine
	1.2 How to Use this Manual

	2 Getting Started
	2.1 What’s in the Package?
	2.2 Additional Documentation
	2.3 Unpacking and Installing 
	2.4  Connectors and Switch Positions
	2.4.1 Connectors
	2.4.2 Switches

	2.5 LED Positions
	2.6 Jumper Settings
	2.7 Bill of Materials
	2.7.1 II-EVB-2128-PLC Motherboard
	2.7.2 II-DB-W2SW1 Daughterboard

	2.8  Schematics
	2.9  Running the iChipConfig Utility
	2.10 Configuring for Connection
	2.10.1 Dynamic IP Allocation
	2.10.2 Fixed IP Configuration

	2.11 Testing the Connection

	3 Firmware and Parameters Update
	3.1 Local Firmware Update
	3.1.1 First-Time Firmware Installation Using Monitor Mode
	3.1.2 Updating Existing Firmware Using the iChip Uploader

	3.2 Managing Parameter Files
	3.2.1 Saving the II-EVB-630W Configuration to an RPF File
	3.2.2  Loading an RPF File



